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introduction Luci® live two
Live two way LOW DELAY broadcast, combined with Luci® edit it can even play pre-recorded material while 
broadcasting 

Congratulations with your choice of Luci® live two! Luci® live two transforms your PC, PocketPC or Smartphone into a 
high quality live internet broadcasting source. Until now you had to use very expensive satellite-time or the suchlike, but 
now, with the emergence of high-speed wireless internet access and the use of Luci® live two, the cost of live 
broadcasting is practically zero. We have also built in the possibility to record while broadcasting live, so if something 
goes wrong you'll still have your original recording to send later on.

Luci® live two has the Luci engine ´under the hood´: you can depend on reliable technology and software, while many 
features of Luci are also available in Luci® live two, like Input-equalizing and support for high-quality accessories. Luci® 
live two can even play pre-recorded material while broadcasting! 

The main features of Luci® live two are listed below

o RTP or UDP low-delay streaming, two-way, so including a return-channel
o N/ACIP, Shoutcast or icecast server compatible
o ipv4 and ipv6 compatible
o Record while broadcasting
o Play pre-recorded material while broadcasting (if combined with Luci® or Luci® Edit)
o Realtime mpeg-conversion to mp2 and many other AAC variations, 48 kHz sample-rate, 32 to 256 kbps. Mono or 
stereo.
o Other codecs available upon request
o Excellent broadcast quality
o Constantly updated to the latest IP-technology and standards
o Application also available for personal computer or laptop
o Free helpdesk via email at support@luci.eu

This manual consist of 5 main chapters

SYSTEM REQUIREMENTS
The kind of devices needed, software compatibility, audio cards, plugs etc. for both users, reporters, backoffice and 
program makers / technicians or web (radio) masters

QUICK INSTALLATION GUIDE
Both software installation and license or registration process is explained in detail for both users, reporters, backoffice 
and program makers

USER GUIDE / WORKFLOW
For users i.e. reporters who are using a PocketPC equipped with Luci® Software

SET-UP TECHNICAL GUIDE
LuciSetup allows backoffice / program makers / technicians or web (radio) masters to define the technical set-up and the 
general behaviour of the software 

HOW TO
Guides for setting up Luci as a server.

system requirements
Luci® Software can be installed on your PocketPC, personal computer or laptop 

In order to install and have optimum use of all Luci® software on your device, you must have one of the following:

For PocketPC:
o Microsoft Windows Mobile 5 and higher
o PPC 2003 SE
o PPC 2003

To see what version you have, go to the Start / Settings / About screen of your PocketPC. Luci for Windows Mobile 5 is 
recommended if you have Windows Mobile 5.

mailto:support@luci.eu


For PC:
o Windows 7
o Windows Vista
o Windows XP
o Windows 2000
o Windows NT

Minimal technical requirements of a PocketPC:
o Processor of 200 Mhz 
o 5 Mbyte of free program-memory

Look at Start / Settings / Memory

Preferred minimal requirements of a PocketPC for ultimate reliability :
o Processor of 400 Mhz 
o Flash-card with SLC technology. Like Transcend 1GB 80X type or Sandisk Premier Micro SD-card.

Preferred requirements of a PocketPC with ease of use in mind:
o Headset input with 2.5 or 3.5 mm jack input. For reliable connection of external microphones
o Non-square screen

Preferred requirements of a PocketPC for maximum connectivity:
o GSM
o Wifi
o HSDPA
o Bluetooth stereo



quick installation guide
Software installation

There are 2 ways to install Luci:

o Download the 'PC-install' program directly from www.luci.eu  /downloads.html   This enables you to install the software 
with your PC through your ActiveSync connection. 

o Download the 'cab’-file directly from www.luci.eu  /downloads.html   with your PDA and start the installation directly on 
your PDA. 

License installation

Start set up in your Programs Folder 

You will now enter the page Register

If you have purchased Luci online via www.luci.eu/purchase  .html   , your 
Keycode request ID will be issued in your order confirmation e-mail. If 
you have purchased Luci any other way you will also receive an e-mail 
with these important numbers. Be sure to save these numbers in case 
you need to re-install your Luci® Software.

Registration is the process of unlocking your software for one particular 
PDA. To unlock, you request a unique 'key-code' that belongs to the 
particular PDA you use to register and want to use Luci on. 

When you buy 1 or more licenses for Luci, you receive only 1 Key-code 
request ID from us that enables you to request the purchased number 
of different key-codes from our license server. For each PDA that you 
register, fill in the key-code request ID and press ‘Request key-code’. 
First,  a  message  appears  to  confirm  that  you  have  an  internet-
connection: 

• If  you have an internet-connection and answer OK you will 
receive the key-code after a few seconds.

• If you do not have an internet connection and still answer OK 
a  license-file  called  ‘Key-code  request  ID’.lrg  (ie 
1234567890.lrg in the example on your left) is copied to the 
‘My documents’-folder. Send this file to sales@luci.eu and we 
will email you the keycode back.If you use a PC , this file is 
located  int  eh  installation  folder  of  Luci,  usually  “Program 
files\Technica Del Arte\Luci Live2\”.

• When  you  do have  an  internet-connection  but  something 
goes wrong you can also email this file to sales@luci.eu. 

After you have pressed 'Request key-code' and you received the Key-
code  it  is  automatically  filled  into  the  field  called  'Key-code'  and  a 
message appears to indicate how many licenses you have left if you 
purchased more than one.

Go to adjust the next page or choose menu “File/Save and exit” to 
save and leave Setup

user guide / workflow
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go live

 

Start Luci live two in your Programs Folder 

You will now enter the main 'Go Live' tool that you use to work with.

EXPLANATORY FIELDS AND BUTTONS 

my station
Tap on this field and you can choose the station that you want to connect 
to if you have more than 1 profile setup with Live2Setup. If you have 
chosen a shoutcast or icecast station you can type in the name of the 
'song-title' that will appear in all of your listeners internet radio player
OUT Level-meter
This is the level-meter of the outgoing signal on the internet. Including a 
peak-hold
IN Level-meter
This is the level-meter of the incoming return signal. Including a peak-
hold and a little light with 3 states: off for no incoming signal, green for 
incoming signal without errors, red when a receiving error occurred
No file loaded
If you load a file for playing while broadcasting, its name will appear 
here. Now it's only telling you that you have no file loaded yet
Default1-00
The name that will be used when you make a recording
00m:00s
The length of the current recording in minutes:seconds
Furthermore you see 2 big buttons and 2 smaller buttons:
The big buttons are the ‘Play-button’ (shown in the OFF-state here) for 
playing a pre-recorded project or file and a ‘MIC-button’ to activate the 
Microphone (internal or external, shown in the OFF-state here).
The smaller buttons are a 'Record-button' (shown in the OFF-state here 
also) to start recording and an ‘Antenna-button’ (shown in the OFF-state 
here) to connect to your internet radio-server.

   

 

connect to your server 

Press the 'Antenna-button'. Luci live two will try to contact your server 
you have setup with Luci live two Setup. While doing so, half of this 
button will flash until a connection is made, then the whole button will be 
lit.

If no connection can be made, flashing will stop after a while and the 
button will not be lit. Try again and / or contact your program producer 
back at the radio station.

   



 

All set ?

Press the MIC-button to go live

You are now sending your Mic-signal to the server. The server will send a 
return audio signal back which causes the Input-light to become green 
indicating you have a valid return signal. You can now communicate with 
the studio.

 

If you're using the PC-version you can not move or close this window 
while you are connected. You must first stop the MIC- and Connect 
-button. This is a security protection against accidental mouse-clicks that 
might stop your transmission.

   

 

Choose a different station 

If you have predefined several station profiles in Luci live setup, you can 
choose the menu-item Tools → Station. Alternatively, you can also click 
on the name of the station ( “my station” in the image above).

 
A small window appears with all stations in a list. Choose one and press 
OK to switch over to that station or just double click on one

You can also sort the stations according to the alphabet or the last time 
you were connected. 

 

user guide / workflow



save live

 

Recording while broadcasting live

You have the ability to save the live audio that you transmit by 
recording the item. This is a precaution in case you loose your 
internet-connection but are still sending important news and you do 
not want your recordings to get lost. Like in Luci Basic it is best to 
define a new project before starting to record.

Choose menu File → New project for recording

Luci will then ask your:

Name
Type your projects name
Folder
Select folder in which all project files should be saved
Type
There is only one type of project to select at this moment
Location
Decide if you want to save the project files in the Main Memory or 
storage card for example. The storage card is recommended

For this example the name ‘Newp’ is chosen.

If you have set up everything, select OK to confirm the settings and 
continue, or Cancel to return.

   

 

Now Go Live by tapping the MIC-button

Then press the Record-button

The time-indicator will start to run and the name besides the Record-
button will be the file you are recording. If you press the Record-button 
again, recording stops. If you then press the Record-button again, 
recording continues in the same file as before. Only if you deactivate 
the MIC-button, this recording will be closed and the filename 
increments to Newp01 to indicate the new filename you will record the 
next time.
You can also record without broadcasting Live: Press Record and 
then MiC or vice-versa. 

 



user guide / workflow
insert pre-recorded material while live

 

You can play pre-recorded material while you are on the air

For this you must first load a single uncompressed wave-file to play. 
The file  must  also  contain  the  same number  of  channels  as  the 
stream you are transmitting. So, stereo file for stereo and mono file 
for mono. Supported sample rates are 44.1 and 48 Khz. Supported 
bit depth is 16 or 24-bit.

To load a single file choose menu File → Open file for playing

After you have chosen the file called ‘My Interview00’ for instance, 
the name will appear above the ‘Play-button’ and the total recorded 
time of this file will appear at the bottom left of this button.

   

 

Add pre-recorded files while broadcasting live

Go live by pressing the MIC-button

After a short live introduction you can now add the pre-recorded file 
by pressing the ‘Play-button’. You will now see that the MIC is 
switched off automatically (for the case where you have set the fade 
to be Auto mic mute in Live2Setup) until the playing of the pre-
recorded file is finished. Then it will switch on again automatically. 

Watch the time-indicator at the bottom left of this button. It will start 
to count down and the ‘Play-button’ will gradually ‘run empty’ (see 
next screenshot). 

If you want to interrupt the transmission of the pre-recorded file: 
press the ‘Play-button’ again, or press the ‘MIC-button’ in order to 
immediately switch over to live broadcasting yourself.

You can of course also transmit only pre-recorded files without 
actually broadcasting live yourself. 

 



 

playing

Watch the time indicator at the bottom left of the Play-button. It is 
counting down and the Play-button will gradually 'run empty'. 5 
seconds left and then this file has been transmitted completely.

 
 



user guide / workflow
keyboard shortcuts
The following keyboard shortcuts are available on the PC:

S = Choose Station

C = Connect

Space-bar= Mic

P = Play

L = Load file or project for playing

Switch on the “button-guard” when you are afraid of accidental keyboard-presses, see Setup/Options page

 
 



set up technical guide
Register

 

Start set up in your Programs Folder 

You will now enter the page Register

If  you  have  purchased  Luci  online  via 
www.luci.eu/purchase  .html   , your Keycode request ID will be 
issued  in  your  order  confirmation  e-mail.  If  you  have 
purchased Luci any other way you will  also receive an e-
mail with these important numbers. Be sure to save these 
numbers in case you need to re-install your Luci® Software.

Registration is the process of  unlocking your  software for 
one particular PDA. To unlock, you request a unique 'key-
code' that belongs to the particular PDA you use to register 
and want to use Luci on. 

When you buy 1 or more licenses for Luci, you receive only 
1 Key-code request ID from us that enables you to request 
the  purchased  number  of  different  key-codes  from  our 
license server. For each PDA that you register, fill in the key-
code  request  ID  and  press  ‘Request  key-code’.  First,  a 
message  appears  to  confirm  that  you  have  an  internet-
connection: 

• If you have an internet-connection and answer OK 
you will receive the key-code after a few seconds.

• If you do not have an internet connection and still 
answer OK a license-file called ‘Key-code request 
ID’.lrg (ie 1234567890.lrg in the example on your 
left) is copied to the ‘My documents’-folder. Send 
this file to sales@luci.eu and we will email you the 
keycode back.If you use a PC , this file is located 
int eh installation folder of Luci, usually “Program 
files\Technica Del Arte\Luci Live2\”.

• When  you  do have  an  internet-connection  but 
something goes wrong you can also email this file 
to sales@luci.eu. 

After  you  have  pressed  'Request  key-code'  and  you 
received the Key-code it is automatically filled into the field 
called 'Key-code' and a message appears to indicate how 
many licenses you  have left  if  you purchased more than 
one.

Go to adjust the next page or choose menu “File/Save 
and exit” to save and leave Setup

You will  now have full  access  to  the  Luci®  Software 
with  all  features  included  in  the  application  of  your 
choice without any interruption.
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set up technical guide
New project

 

Start set up in your Programs Folder 

Select page New Project 

EXPLANATORY FIELDS AND BUTTONS

Select folder+name
Enables you to select the default folder and name of a new project 
that is used for recording.
Output format
Stereo
Tick this to broadcast in Stereo. 
AAC-HE
If you don't have any other codecs installed, you can only choose 
MP2. Other codecs can be obtained by purchasing the correct plugin 
. Activating a plugin will be done during registration. If you buy a 
plugin after registration you simple re-register with the same keycode 
and the plugin will be activated.
Bitrate (Kbps)
The bitrate is adjustable. The sample frequency is ALWAYS 48 kHz, 
even if a PocketPC can only record with 44.1 kHz maximum. Luci 
contains sample rate converters that are automatically activated 
when necessary during recording and playback without you having to 
do anything. Adviced bit rates are dependent of the codec used: 
MP2: 48 to  256 kbps.
AAC mono: 32 to 160 kbps
AAC stereo: 64 to 256 kbps
AAC-HE mono: 16 to 64 kbps
AAC-HE stereo: 16 to 128 kbps
AAC-HEv2 stereo: 16 to 56 kbps.
AAC-HE oversampled SBR stereo: 96 to 256 kbps.
ps.: Not all codecs are available on PocketPC or smartphone
Record format
If the user records with the main program, you have 2 options for the 
format of the recording:
Output format – the recording will be done using the same format as 
set above. This feature is very useful if you want to locally backup 
everything that is transmitted without the need of playing this live 
again.
Wave – the recording will be done in uncompressed wave-format.
This is useful if you want to use the recording in Luci Edit or in Luci 
Live2 again.
Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

 
 



set up technical guide
Stations1

 Start set up in your Programs Folder 

Select page Stations1
EXPLANATORY FIELDS AND BUTTONS FOR THE RTP 
AND UDP PROTOCOL 

Profile
You can store up to 100 server profiles. In live two you then have the 
ability to choose between them. You will see a drop-down list with all 
currently defined profiles and a profile called ´New´ that enables you 
to add a new profile and ´Delete´ that will delete the currently 
selected profile. If you have only 1 profile you can not delete that.
Each profile can use a different output format. If you choose Output 
format “New project” this profile will use the general output format as 
set before in the 'New project” page. Look at the 'New project' setup 
for explanation about the different available formats.
Server
The name of your radio server and port-number. In the common 
form: ´servername:portnr´ for instance ´radio789.com:5004´. If you 
do not fill in the :portnr Luci will use the default port, which is 5004. If 
you use Luci live two only as a receiver i.e. server do not fill in the ip-
address. But fill in :5004 for instance(including the colon). It will still 
send a stream back when it receives a valid stream.
Besides using a URL you can also fill in an ip-address. 
For ipv4 for instance: 192.168.1.100
For ipv6 you should put the address between square brackets like 
this: [2001:980:4937:1:1483:291:1351:a206] . You can of course also 
use a URL with ipv6.  
User
Fill in the user-name you use to login at your server.
Password
Fill in the password belonging to your user name. This password can 
also be used in a simple RTP authentication.

Protocol
Shoutcast, Icecast, RTP, UDP or N/ACIP
Luci Live two's use of the UDP and RTP protocol is explained 
extensively in the server installation guide. We advice to use RTP on 
port 5004 .
N/ACIP
For this protocol you should use the following conventions for the 
different fields.
Field Server: “user@URL:port”
So, “user” is the one who you want to call. If you want to call without 
specifying a user name, just enter here something like “dummy”.
Some examples:

• “502@204.24.156.12:5062″ means you want to call user 
502 at ip-address 204.24.156.12 on sip-port 5062

• “echo@iptel.org” means you call user echo at iptel.org on 
sip-port 5060 (5060 is the default when no port has been 
specified). Btw, this address actually works, but only with 
G711 codecs.

Fields User and Password are YOUR credentials when you want to 
logon to a sip-server. When you do NOT specify a user, Luci will not 
try to REGISTER to the sip-server.

Use global RTP/UDP settings
You can have different RTP/UDP settings per station or you can use 
the global RTP/UDP settings set with the RTP/UDP page. For an 
explanation of the settings, see the RTP/UDP page.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup



EXPLANATORY FIELDS AND BUTTONS FOR THE 
SHOUTCAST AND ICECAST PROTOCOL 

If you have chosen the shoutcast or icecast protocol you will see 
another feature list, as can be seen on the left. Some features are 
removed, others are added:
Mount
The mount-name, for Icecast servers.
Stream name
The name of your radio-station.
Test
You can test your server-settings with this button. Luci live two will try 
to contact your server.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup



set up technical guide
Import station list

 

To save you the burden of manually inputting a long list of 
servers you can use also use a spreadsheet to define your 
stations and imort this spreadsheet in Setup.
File-format  is  csv  (comma  seperated  values),  this  is  a 
common format  for  simple  lists  which  can  be  made and 
edited with any spreadsheet or even text-editor. Below you 
see an example list. The first line of the csv-file must be the 
same as the first line of this example.
All entries are not case-sensitive while the is optional. Each 
line  beneath  the  first  line  represents  a  different  server-
profile.

Entries are self-explaining, for the encoder format use the 
same words as in the drop down menu’s of Live2Setup.

 

 



set up technical guide
Stations2

 

Start set up in your Programs Folder 

Select page Stations2
The user can update the list with a station-list you can store 
on any webserver. Format (CSV) is the same as import 
station-list. 

EXPLANATORY FIELDS AND BUTTONS.

External station file URL
Only when a URL is entered the user will see a button called 
“Update” in the “Choose a Station” window, see image below. The 
imported stations are appended to the local list from Live2Setup and 
cached locally. The list is always updated manually, no automatic 
update takes place.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

The user will see a button called “Update”.



set up technical guide
RTP / UDP

 

Start set up in your Programs Folder 

Select page RTP / UDP 
EXPLANATORY FIELDS AND BUTTONS 

Output
64kbps upload max.
If you have an upload connection of only 64 kbps you must tick this 
box. Luci will then only allow you to choose bitrates of 32,48 and 56 
kbps. And because extra bytes have to be sent for the internet 
protocol, Luci will also optimize the data that is sent so that it really 
fits 64kbps with the shortest possible delay.
Send password
Only valid for RTP protocol. Luci will encrypt the password and send 
it with the RTP-protocol in the so-called SSRC field. At the receiver, 
this can then be used to authenticate a stream. 
This is not standardized within the RTP protocol but is a simple way 
to add extra security and authentication. At this moment this only 
works with Luci at the receiving end.
QOS
Quality Of Service uses the DiffServ conventions to define the type of 
stream that Luci sends in ipv4 or ipv6 packets. You can set the type 
“Voice”  for maximum priority and “Audio/Video” for slightly less 
priority as Voice.
Flow control
When QOS is set you can enable “Flow control” which will let the 
Windows OS manage the stream better as the streaming bitrate will 
be known to the OS.

Input
Extra jitter-buffer
Fill in the number of milliseconds you want to use for the buffer to 
compensate for network-jitter.
Filter on password
Only valid for RTP protocol. If you receive a stream from another Luci 
live two you can refuse any stream that hasn't got the same 
password set as you.

Compatibility
Choose the compatibility mode when you connect to an IP-codec 
that needs special signalling to work with Luci. At the moment we 
only have a Mayah Centauri compatibility mode where you can 
choose the format and bitrate of the return-signal.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

 
 



set up technical guide
Play

 

Start set up in your Programs Folder 

Select page Play 
Here you can set how the Mic-input is muted when you play pre 
recorded files. You can choose to mute instantly, or fade in and out, 
or even gently cross-fade.

EXPLANATORY FIELDS AND BUTTONS 

Fade type
In this drop-down menu you will find 5 options:

1. Auto Mic mute
The Mic is muted instantly when you press the play button 
and is automatically switched on when the playing stops.

2. Manual Mic mute
When you start to play the file the Mic is only muted when 
you manually switch it off. You must also manually switch it 
on again near the end of the playing file. 

3. Auto Mic fade
Like 1. but now the Mic is faded out with the fade-time you 
set in the below field 'Mic fade out time'. The same goes for 
the fade-in near the end of the playing file.

4. Manual Mic fade
Like 3. but now you have to manually start the fade-out and 
fade-in. 

5. Auto Xfade
A gentle cross-fade is made between the playing file and 
the Mic. Using the fade-out and -in times set below. Fade-
out time is for when you start playing the file. Fade-in time is 
for near the end of the playing file.

Mic fade out time
Type in the nu,ber of milliseconds you want the fade-out to last.

Mic fade in time
Type in the nu,ber of milliseconds you want the fade-in to last.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup.

 
 



set up technical guide
InputEQ

 

Start set up in your Programs Folder 

Select page InputEQ 

The 'Input EQ' enables you to perform some equalizing during 
recording so you can improve the frequency-response or sound-
quality of any Pocket PC. We also added support for saving and 
loading presets, so you can use equalizing for already known Pocket 
PC's. 
Check http://www.luci.eu/downloads.html for available EQ presets.
To set or adjust the EQ yourself you have the ability to play a 
prerecorded un-EQ'd wav-file, while you are adjusting the EQ: 
If you do not have Luci installed yet, install Luci. First you use 
LuciSetup to enable Luci to record a wav-file ( 'new project'-tab) and 
no Input EQ (deselect 'EQ Enable'). Start Luci, create a new project 
and record a test-file while you are speaking into the microphone you 
are going to use, the recorded file will be called 'default00.wav' for 
instance. Quit Luci and start live two Setup, go to the Input EQ and 
press 'Play file', you can choose any wav-file you have recorded 
earlier, but for this example choose 'default00.wav'. The recording 
will be played continuously, so you can now set the EQ to improve 
the quality of the recording. Be sure to select 'EQ Enable' and press 
'On' for every band you want to use.

EXPLANATORY FIELDS AND BUTTONS 

Allow profile selection in Luci
Switch this on to allow the user to choose an Input EQ type you 
predefined here. This allows them to use different EQ settings for 
internal Microphone, external Microphone of type A, external 
Microphone of type B , etc.
Profile
Choose a profile or give a profile a name. You can define 5 profiles 
maximum.
Overall gain
Set the overall gain of this EQ setting.
High – Mid - Low
There are 3 parametric bands available: low, mid and high. You can 
individually switch On or Off each band.
EQ Enable
Here you can switch On or Off the EQ all together. 

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup
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set up technical guide
I / O 

 

Start set up in your Programs Folder 

Select page I / O 

The I/O (Input / Output) tab enables you to setup the audio input and 
output.

EXPLANATORY FIELDS AND BUTTONS 

Audio Input
Choose the input you want to use from the drop-down menu. 
Check Sample-rate
Many PDA's have a sample-rate that is not as accurate as one likes 
it to be. With this option you have the ability to measure the exact 
sample-rate of your PDA and let Luci compensate for this inaccuracy. 
To measure, press the button 'Check sample-rate' and wait until the 
sample-rate stabilizes. You will see the real sample-rate of your PDA 
appearing to the right of the button. 44100 is the value it is supposed 
to be. Some PDA's have a sample-rate that is even as high as 44300 
Compensate in codecs
Mark the box 'Compensate in codecs' to let Luci compensate for any 
inaccuracy encountered in the sample-rate. 
On a PC this is not necessary.

Audio Output
Choose the output you want to use from the drop-down menu. 
Check Sample-rate
Same as above
Compensate in codecs
Mark the box 'Compensate in codecs' to let Luci compensate for any 
inaccuracy encountered in the sample-rate. 
On a PC this is not necessary.
Force mono
Force the output to be mono always even when a stereo stream 
arrives. This can be useful for devices that can not output a stereo 
audio-signal.
Generally , switch this On on the remote device and Off when Luci is 
used as a server.
Audio buffer length
Here you can set the buffer-length of the Audio I/O. Usually the 
default of 50 ms is a good setting, but for a low performance 
soundcard on Windows Vista or Windows 7 this should be set to 100 
to 200 ms.

Sample-rate:
Choose the sample-rate for the input and output you want to use. Be 
careful with a PocketPC ! If you set it at 48 Khz Windows Mobile will 
probably sample-rate convert it to 44.1 Khz for the audio-drivers to 
function properly. It's best to leave it at 44.1 Khz on a PocketPC and 
let Luci's high-quality sample-rate converters convert it to 48 Khz. On 
PC it's generally safe to set it at 48 Khz.

ASIO
If you have a soundcard with ASIO driver you can choose it here.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

 
 



set up technical guide
Options

 

Start set up in your Programs Folder 

Select page Options 
The Options tab enables you to switch On the display of several 
features of the 'Go Live' tool in Luci live two. In addition you can also 
switch on and off some options concerning the behaviour of Luci 
Live2.

EXPLANATORY FIELDS AND BUTTONS 

View
Switch on and off some features in the 'Go Live' tool.
Max. Recording time
Show the maximum recording time available
Battery-state
Show the battery-state
Digital gain knob
Show a gain knob in order to adjust the gain of the input.
Output Volume knob
Show an output volume knob in order to adjust the output level.

Go Live
Check this and live two will go on air immediately after starting up

Try to minimize I/O cross-talk
If you experience cross-talk of the return-channel into the signal that 
is broadcasted, tick this. Luci will then try to reduce this. This only 
works when an external microphone is connected.

Button-guard
If you enable this, Luci Live2 will ask you for confirmation when you 
want to stop the live-stream.

Disable Activesync
Activesync sometimes inteerupts the processor to perform tasks in 
the background, this might causes interruptions in the Live 
transmission. With this option On Luci will shut down Activesync 
when you go Live. It's best to switch this on.

Auto Connect
On a PDA only. Connects your PDA to the internet automatically 
when you want to stream ( press the Antenna button ).

Choose menu “File/Save and exit” to save and leave Setup.
 



how to 
setup and connect Luci live two with another Luci live two
As Luci Live two works in both ways it is easily possible to connect two Luci Live two's together. RTP is the preferred 
protocol for this. Here is how you setup and use Live two in several network situations.

 Both on the internal network.

 

Set the one that's at 192.168.1.102 to connect to the other: 
192.168.1.100 at port 5004.

If your network uses computer-names you can also use these 
names instead of the ip-address. So if for instance 192.168.1.100 is 
a computer called "intcomp1" you can also fill in " intcomp1:5004 " 

If your network uses a DHCP-server, using the computer-names is 
also the best way to connect.

 

Set the one that's at 192.168.1.100 to connect to the other: 
192.168.1.102 at port 5004.



 

Start Luci Live two on both, choose the station (rtp int1 for the first in 
this example) and set them both to connect, like on the left. They will 
then both listen for an incoming stream on the RTP-port. As soon as 
one wants to talk, press on the Mic, the stream will arrive at the 
other end and the other listener hears the other talk and can decide 
to start talking also by pressing the Mic button.

One side on internal network, the other the 
internet 

 

 This is the common case when you have reporters in the field with 
Luci Live two on their PDA or laptop and they want to transmit live to 
the studio for direct transmission on-air. 

The studio will have it's own static ip-address and may even have 
webservers running in house. Luce Live two will then have to be 
configured for use as a live contributor on the PDA and as a server 
in the studio. 

First thing you have to do is to make sure that the port for RTP 
(normally 5004) is forwarded to the computer where your copy of 
Luci Live two is running on (call it a Live-server). This is exactly the 
same as what you do when you forward traffic for your webserver on 
port 80 to your webserver.

 

On the Live-server 

All you have to do is to not fill in the name or address of the server 
(ie. no server) like on the left.

Notice there is no ip-address or URL filled in. Please don't forget the 
colon before the port number. 
This will cause Luci Live two to listen to incoming streams and not 
send any stream if there is no stream coming in. If it receives a valid 
stream, it will start sending back to the Ip-address and port where 
the stream is coming from. This technique is commonly known as 
"Symmetric RTP" .

You should use this in combination with the Start-up option "Go Live' 
in the Options-page of setup.This will cause Luci Live two to 
immediately start listening when you start the program. It is also 
wise to put a shortcut to Luci Live two in the startup-folder of your 
PC, so it starts automatically each time the computer restarts. 



 

On the PDA 

You have to fill in the public ip-address or URL of the studio. Like on 
the left. 

 
 



how to 
setup Luci Live two as a server

 Any Luci Live two can act as a mono or stereo server for 
high quality audio over IP.

 

To make Luci Live two act as a server, do not fill in any ip-
address in the "server"-field at the "Server"-page in 
Live2Setup. Like you can see on the right. Don't forget to 
add the colon ( : ) before the port you want to use. This will 
cause Luci Live two to listen to incoming streams and not 
send any stream if there is no stream coming in. If it 
receives a valid stream, it will start sending back to the Ip-
address and port where the stream is coming from. This 
technique is commonly known as "Symmetric RTP" .

To be able to connect to the server from outside your own 
network, you must make sure that the port for RTP 
(normally 5004) is forwarded to the computer where your 
copy of Luci Live two is running on (call it a Live-server). 
This is exactly the same as what you do when you forward 
traffic for your webserver on port 80 to your webserver.

   

 
 



how to 
setup Luci Live two as a multi-channel server
 It is possible to start Luci live two several times simultaneously on the same PC with different settings. Then there 
are multiple so-called "instances" of Live2 running which enables you to receive multiple streams simultaneously. To 
accomplish this do the following.

 

 1.Download live2.zip  

 2.Create as many folders on your harddisk as 
you want multiple Live two's running. For instance 
Live2a,Live2b and Live2c 

 

 3.Copy the contents of the downloaded zip-file to 
each of these folders.

 

4.Start Live2Setup in each of these folders and fill-
in a port-number as the server, like :5004. Each 
instance should have a different port-number , 
something like :5004, :5006 and :5008 

5.Also switch on "Allow multiple instances" and 
"Go Live" in the Options-page in all Live2Setups. 

http://www.luci.eu/downloads/PC/live2.zip


6.Also choose a different Audio input and output 
for each instance in the I/O-page in Live2Setup. 

 7.Copy shortcuts to the individual live2.exe 
programs in the folders to the start-up folder of 
your computer.

 

 8.Restart your PC or start the programs all up 
individually, arrange the windows across the 
screen.

 

  
You now have the ability to receive multiple simultaneous mono or stereo streams that are output at different audio-
outputs. Each stream also has separate return-channels. 
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